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| Heredis Online
Heredis Online
Heredis includes the creation of a personal online website for displaying your genealogy. No need to use
a service provider, your data is hosted for free on Heredis Online. You have a real website dedicated to
your genealogy, searchable by your family, friends and other genealogists, who will all have an overview
of who your ancestors were, places where they lived and the various documents that you have found
concerning them. In addition, Heredis allows you to be contacted by any person who is interested in your
genealogy.

Create a Heredis Online account
You must create a Heredis Online account before publishing your genealogy, allowing you to access your
account, to modify or delete published genealogies and to be identified as a person hosted by Heredis
Online.
1. Click the Heredis Online button
and choose My account or choose File > Heredis Online >
Manage My Account from the menu. You can manage your account from the home page too.
2. Click the Create A Free Account button. Enter your email address, your username and your password.
Complete the identification data and check out the Heredis Online Terms of Service and then tick the box.
Register or create a Heredis online account
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3. Click OK, your account is created.
Managing account information
Log in by entering your username and password. Do not forget to tick the Remember me box for the data
to be stored for future use.
The Account Management screen allows you to change your login information and your address. Click
the Edit button to access it.
Once you have published genealogies, they will appear in the lower part of the window.
Managing your publications
Click on the Visit Website link to view your online genealogy.
Click the indented wheel
icon to change your settings for publication. There is no need to republish
in order to view notes in your online genealogy, or to hide data which is less than 150 years’ old. Once
you have changed the settings, they are applied to your personal website.
Click on the

button to delete the genealogy from your personal website.

Info • you can carry out these operations remotely, even if you do not have your computer to hand, by
connecting to your Heredis Online account from any Internet browser.

Publish a genealogy to Heredis Online
Click the Heredis Online button and choose

Publish.

Customize your site by giving it a name. Heredis will place by default that of your genealogy file. You
may change the name because it will be included in the URL that you will communicate to your relatives
and friends.
From the Your Website tab, add an illustration to your homepage to make it more attractive. You can
display the main image associated with your root person, or select a photo from your hard disk: the village where your ancestors originated, a shield. Browse your hard disk to select an image.
Customize your Heredis online website settings
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Fill out the host text area; anyone who connects to your site must have an idea of what he will find there!
You have the choice of data you publish from the Privacy tab:
Manage the display of contemporary persons by choosing the number of years to set the privacy
level and decide if you want to display the full given name and surname only or not to display at
all.
Display or not individuals who are declared as confidential or private in your genealogy file
(individuals, events, notes ...)
Choose to display or not all notes
Display or not all sources
You may also tick the Protect this publication with a password box, and enter a password in the
corresponding text box and click OK. Thus, only the holders of a visitor password can access your
publication. Other visitors will contact you by email to get the password.
Heredis Online displays a list of your published genealogies. You may follow the progress of moving
your genealogy to your personal website. When publishing is complete, click on the link to launch your
Internet browser and visit your site.
You will arrive on the home page of your genealogy. Click the Facebook button to share your genealogy
on your Facebook page or click the Email button to send an email and share your genealogy website
with your family and friends.

High-resolution photos on Heredis Online
The first time you connect to your Heredis Online account from Heredis 2018 18.1, a message will
inform you that the photos you publish online are displayed in high resolution.
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In the Media Index, the Sent and Not Sent filters, as well as the media Status displayed under the
Information tab, allow you to visualize the list of the media that are online or not.
When you publish a genealogy on Heredis Online, each media has a Status (that you can see in the
Details tab from the Photo tool) that allows you to clearly identify its current situation: File is online / File
is too large / File error / File waiting to be sent / Unauthorized file format / Missing file / File being sent /
Unverified file.
Note:
• In the software preferences, using the menu (PC) Tools > Preferences > Heredis Preferences >
Advanced ; (MAC) Heredis World 2018 > Preferences > Advanced, you can indicate whether you
want a copy of your media to be uploaded.
You can also choose to adjust the uploading of these media based on your internet connection. By default,
the uploading is based on an ADSL connection type with a 50% usage. These parameters can be modified
and personalized at any time but won’t be applied until you restart your software.
• In your Heredis Online account:
You can choose whether your media should be displayed in a publication: click on the
indented wheel
button, then click on the Privacy tab, then make your selection in Show photos.
The media that are not linked to any publication can be deleted; to do so, click on the Online Medias tab
in your Heredis Online account.
• If you realize the media are not uploading properly and that the status of your files reads "File error" or
"Unverified file", you can force send them from the Media Index by clicking (PC) the Tools button /
(MAC) on the indented wheel Option button and selecting Reset sending of online media. You will
need to quit and restart Heredis for the uploading of the media to resume.
• Files with the following extensions cannot be uploaded: «exe», «app», «bin», «zip», «rar», «sit», «cab»,
«ace», «arj», «lha», «lzh», «lzx», «zoo», «arc», «ice», «ics», «7z», «tar», «gz», «gzip», «tgz», «z», «bz»,
«bz2», «hqx», «sit», «sea», «uue», «apk», «dmg», «bat», «sh», «asp», «php», «js», «jse», «iso», «iss»,
«msi», «jar», «war», «bak», «sav», «old», «log», «pif», «py», «pyw», «rb», «ged», «heredis», «mdb»,
«sqlite»
• Files over 4294967295 octets (~4.2 Go) cannot be uploaded either.

Publish group photos to Heredis Online
Heredis allows you to publish group photos on your personal site, as you do for your genealogies.
You will certainly have photos in which you have not been able to identify all the persons present in the
photo. Heredis offers tools for identifying these persons and then for publishing the photo in a photo
album.
This online album may be viewed by your family, your friends and other genealogists. Thus, visitors to
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your site may not only view your photos but contact you if they have recognized people in the photo.
In Heredis, you access this functionality from the Identification tab in the photo tool (for details on this
tool, refer to the section The photo tool).

Create and set an album
Once you have identified all the persons in a group photo, you may now share your photo album online
by clicking the Publish Button at the bottom right on the Identification tab.
A simple interface allows you to connect to your account or create it if it is the first time you use Heredis
Online.
When first published, you can change the title of the photo in the Title field. If you want to publish this
photo in another album, unfold the dropdown list and choose the appropriate album, or create a new one
by using the + button.
To personalize this album, click the indented wheel

to the right and you can:

give it a name that will be included in the URL that you will communicate to your family or to
other genealogists. Do not worry about spaces, Heredis replaces them automatically by
underscores.
add artwork to make your homepage more attractive.
give details of the content of this album in the Description text box. The person who visits your
site will have an idea on what he or she will find in it!
You can protect your album by a password. Net users who know the password may view your album
online and others will contact you by email to get the password.
When all the settings of your publication are satisfactory, click the Validate Button. Your photo is now
published on Heredis Online.
Info • When you publish a photo which has been declared as private in Heredis, a message alerts you and
asks for confirmation before continuing the publication.
Settings and management of your albums
You can at any time access the albums published from the Album tab in your account with Heredis
Online.
Click the
indented wheel to change the publishing settings for an album or on the cross to delete it.
Please note that you will delete all the photos attached to this album.
Info • You can carry out these operations from a distance, even if you do not have your computer to
hand, by logging into your Heredis Online account from any Internet browser.
Click the album name to display a list of all the photos in this album. You can edit or delete each picture
individually.
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Consult an album
By clicking on the link Visit album, Heredis opens the home page of the album selected in your internet
browser.
Consulting an album on Heredis Online

In the left sidebar, you have the name of the album and its author, a clickable link to contact the author
and immediately below, two tabs Photos and Persons.
In the Photos tab, a list of photos in the album is displayed and the total number of photos, (in brackets)
next to the name of the tab.
In the Persons tab, the list and the number of persons identified in the various photos in the album are
displayed, specifying, for each identified person, the number of times he/she has been identified in the
various photos of the album. You also have a search box to locate any person in the list.
The central part allows for 3 different views of the album based on the tab selected in the upper part.
From the Home tab, you get an overview of your album where you will find the description text, any
selected artwork and the pictures of the album in the form of thumbnails. To the right, Heredis displays
the date of the last update of this album as well as a list of your genealogies and other albums already
published on Heredis Online.
A single click allows you to open a new tab in your browser with the publication of the selected album.
The Photos tab displays each photo in the album in full screen. To the right of the photo, you find the list
of numbered persons and below, the commentary and the date if they have been added from the Heredis
program.
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A button under the photo, also allows you to hide or show the frames numbers on the photo. Hover the
mouse over any person identified in the photograph and the list shows the person concerned and vice
versa.
Clicking on a person allows you to display him/her in detail in the Persons tab. You will then see the
information collected for that person and a link to the publication if he/she is present in a genealogy
previously published on Heredis Online, as well as photos, in the form of thumbnails, in which he/she has
been identified.
When you click on a photo from the Photos tab in the left sidebar, Heredis automatically switches to the
Photos tab in the central area and displays the details of the photo. If you are on the Person tab in the left
sidebar, click on any person and you will move to the central area of the persons tab this time to display
all known information concerning this person.
To go back to the general presentation of the album, click Home in the banner at the top.

Sharing an album
If you want to invite your family and friends to check out an album, send them the URL by email, or
share it on Facebook. Use the Buttons located in the upper right panel.
As a visitor to a Heredis Online album, you can easily send additional information or indicate an error to
the author of the photo albums. Perhaps you have recognized an unidentified person. Click Contact the
author in the left sidebar under the ALBUM area or in the footer and you will thus advance the work of
the author.

Private access
You may protect your Heredis Online site with a password. Only visitors who know the password will be
able to view details of your online genealogy. When any new web user visits your site, we will invite the
person to contact you to obtain your password.
To implement this password: from your Heredis Online account, select the publication concerned and
click the indented wheel to access the settings for this publication. Then, tick the Protect this publication
with a password box, enter a password in the corresponding text box and click Validate.
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